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End User License Agreement
IIMMPPOORRTTAANNTT - PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THIS SOFTWARE. BY CLICKING THE "ACCEPT" BUTTON OR BY
USING THIS SOFTWARE, YOU AGREE TO BECOME BOUND BY THE TERMS OF THIS LICENSE.  
IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT USE THIS SOFTWARE, AND PROMPTLY RETURN IT TO THE PLACE WHERE
YOU OBTAINED IT FOR A REFUND IF APPLICABLE. IF THE PRODUCT DOES NOT HAVE A PHYSICAL PACKAGE, ERASE THE SOFTWARE AND
ITS INSTALLER IMMEDIATELY.
IF YOU "ACCEPT" OR USE THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ THESE  STATEMENTS AND AGREEMENTS, THAT
YOU UNDERSTAND THEM, AND THAT YOU AGREE TO BE BOUND BY THEIR TERMS.  
The enclosed computer program(s) ("Software") is licensed, not sold, to you by n’PINE, Inc. ("nPINE") for use only under the terms of this
License, and nPINE reserves any rights not expressly granted to you.

11 .. LLIICCEENNSSEE..    
(a) nPINE grants you a non-exclusive license to install and use the machine executable, object code version of Software, related
documentation, and updates thereto made available by nPINE solely for the purpose of using the Software in accordance with the
accompanying electronic documentation.  
(b) You may use one copy of the Software on a single computer at a time. 
(c) You may use the Software for your own personal or internal business use and not in the operation of a service bureau or publicly
accessable computer or for the benefit of any other person or entity. 
(d) You may make one copy of the Software solely for backup purposes, provided that all copyright and other proprietary notices are
maintained on the copy of the Software.
(e) You may permanently transfer all your rights under this License to another party by providing to such party all copies of the Software
licensed under this License together with a copy of this License and the accompanying written materials, provided that the other party
reads and agrees to accept the terms and conditions of this License.
(f) Notwithstanding any other terms in this License, if the Software is licensed as an upgrade or update, then you may only use the
Software to replace previously validly licensed versions of the same software.  You agree that the upgrade or update does not constitute
the granting of a second license to the Software.
22 .. RREESSTTRRIICCTTIIOONNSS..    
You may not use, copy, modify, or transfer the Software, or any copy thereof, in whole or in part, except as expressly provided in this
Agreement.  You may not reverse engineer, disassemble, decompile, or translate the Software. Any attempt to transfer any of the rights,
duties or obligations hereunder is void. You may not publish, display, disclose, modify, rent, lease, loan, resell for profit, distribute, or create
derivative products based on the Software, or any part thereof.
33 .. TTEERRMMIINNAATTIIOONN..    
This License is effective until terminated. This License will terminate immediately without notice if you fail to comply with any provision of
this License.  You agree upon termination to promptly destroy the Software and all copies thereof.
44 .. LLIIMMIITTEEDD  WWAARRRRAANNTTYY..    
The software is provided to you "AS IS" and nPINE and its suppliers expressly disclaim all warranties and representations, express, implied or
statutory including the implied warranties of merchantability, fitness for a particular purpose, and non-infringement.  nPINE does not warrant
that the functions contained in the software will meet any requirements or needs you may have, or that the software will operate error
free, or that any defects or errors in the software will be corrected or that the software will be compatible with any particular platform.
nPINE warrants for a period of ninety (90) days from your date of purchase that the media, if any, on which the Software is recorded will
be free from defects in materials under normal use.
55 .. LLIIMMIITTAATTIIOONN  OOFF  RREEMMEEDDIIEESS  AANNDD  DDAAMMAAGGEESS..
In no event will nPINE or its parent or subsidiaries or any of the licensors or suppliers be liable to you for any lost profits, lost data, business
interruption, loss of business information or cost of cover and the like, or other special, punitive, indirect, incidental or consequential
damages of any kind arising out of the use or inability to use the Software or any data supplied therewith, or for any claim by any other
party even if nPINE has been advised of the possibility of such loss or damages and whether or not such loss or damages are foreseeable.
In no event shall the liability of nPINE exceed the amount received by nPINE from you for this software license. 
66 .. CCOOMMPPLLEETTEE  UUNNDDEERRSSTTAANNDDIINNGGSS
By opening this package or using this Software, the user agrees to be bound by the terms of this agreement, which include the software
license and the limited warranty. This Agreement applies to the user and any subsequent license of this Software. This Agreement shall not
be modified except by a subsequently dated written amendment or exhibit signed by both parties by their duly authorized representatives

THE SOFTWARE IS PROTECTED BY THE COPYRIGHT LAW AND INTERNATIONAL TREATY.

Copyright 1996-2002, nPINE, Inc. All rights reserved.
info@mathmagic.com
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Thank you for purchasing MathMagic.

MathMagic is an XTension software for editing professional
mathematical expressions within QuarkXPress.
MathMagic provides you with powerful, intuitive and easy-to-use
user interface. You can easily create any combinations of
mathematical expressions for various usages such as
mathematical textbooks, physics, electronics, or accountings.

Without MathMagic, you had to create equations in external
editors and then import them to QuarkXPress, which required
multi-steps even for a small modification. You had to spend
more time and had a pain for modification of the equations with
previous ways.

Since MathMagic is an XTension, providing easy and simple-
steps for your work, you can create, correct and modify any
equations right within the QuarkXPress windows. Especially,
when you need to publish materials or books for mathematics
that require repetitive works, you can get great productivity with
MathMagic.

Please enjoy powerful and easy-to-use features of MathMagic
and its quality fonts for your publishing needs.

1. MathMagic Guide
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1.1 Key Features of MathMagic

Easy-to-use User Interface
MathMagic helps you to create and edit complex mathematical equations
via point-and-click user interface. Users can easily create any mathematical
equations using intuitive Equation Palettes of MathMagic.

Intelligent WYSIWYG editor
The MathMagic Editor based on WYSIWYG interface, offers several additional

features for easy editing of equations. MathMagic automatically completes field

creations, arrangements and type size controls for you expressions, so you donÕt

need to consider each size, locations and intervals of the expressions. 

Capability to build every imaginable kind of equations
MathMagic can create all kinds of currently existing mathematical expressions
ranging from elementary school to graduate school.

Additional fonts for high quality output
MathMagic offers specially designed TrueType symbol fonts for high quality

editing on screen. Also it comes with high-resolution PostScript fonts for the

professional desktop publishing. InfoLogic keeps working on designing new

equation symbol font sets that will be offered to our registered customers

continuously.

If you need more details on the PostScript fonts, please contact our sales team.

Email: sales@mathmagic.com

TEL: +82-2-3676-4883

FAX: +82-2-3676-4882
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Save As EPS Format
MathMagic can save your work as EPS format, giving you chances to be used

with other graphic, presentation or DTP applications.

Save As PICT Format
MathMagic can also save your work as PICT format, so you can use it with
other Macintosh applications such as wordprocessors or graphic applications.

TeX Support
MathMagic supports TeX - the professional scientific publishing format, so you 
can publish high-class scientific articles, books, journals and coursewares more
easily. MathMagic can easily convert between equations and TeX, offering
convenient additional features for editing.

Color Trapping
MathMagic supports color trapping, which will allow you to work with high-end
color printing job.

Customizable User Palette
MathMagic provides a useful feature that lets you create your own palette. With 
this feature, you can set up your own custom palette containing frequently used
expressions and symbols to save time with your repeated works.

Multilingual Environment
MathMagic fully supports 2-byte language environments. It can be used with

Korean, Japanese and Chinese versions of QuarkXPress as well as English

version, giving you complete multilingual publishing environments in equation

editing. Each locale version is available separately from MathMagic web site.



MathMagic™4

Macro Support
MathMagic lets you create macros for commonly used expressions. You can

easily choose any macro in the MathMagic Macro palette.

Compatibility with QuarkXPress v4.x & v3.3
MathMagic is fully compatible with QuarkXPress v4.x as well as v3.3.

Free MathMagic Viewer XTension with TrueType fonts
MathMagic Viewer is to display and print documents which have equations

created with MathMagic XTension. It is provided freely for you to send with

your documents to any service bureau or other people who do not have

MathMagic XTension.

Hotkey Support for User palette and Macro palette.
MathMagic lets you define hotkeys for user palette items and macros.
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1.2 The contents of MathMagic package
MathMagic XTension is provided by ESD(Electronic Software Distribution),
which is “Online” downloadable installer CD image without physical
package. 

MathMagic installer CD image contains

• MathMagic XTension Installer
• MathMagic Viewer Installer
• User Manual in PDF format
• MathMagic fonts sampler in PDF format
• MathMagic Fonts Installer - TrueType and PostScript fonts

MathMagic Fonts can also be installed by either MathMagic XTension
installer or MathMagic Viewer installer. 

Contents are subject to vary without notice. 

1.3 System Requirements
PowerMacintosh or Compatibles.
Mac OS 8.1 or higher is recommanded.
(may work with Mac OS 7.1.2 or above.) 
QuarkXPress 3.3 or 4.x. (QuarkXPress 5.0 is not supported yet) 
3MB of available memory
10MB of available disk space
Internet connection to download MathMagic installer 
(downloadble from any computer around the office, and transfer the installer to the target Macintosh)

Notes
This product runs on Mac OS 7.1.2 or above. If you are using earlier
versions of Mac OS, you should upgrade to the latest system software
before you install MathMagic. Mac OS 8.1 or higher is recommended.
This is an XTension software that runs within QuarkXPress, requiring
QuarkXPress software to run. You cannot run this software alone. 
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1.4 Notes before Installation
Please read this user guide carefully before you install. If the software is not
installed properly, you may not use it.
If you encounter any problem, please contact our customer support team.

The authority to use MathMagic can be obtained via Online or Key Diskette. 
If you received the SERIAL NUMBER and CUSTOMER NUMBER by email
or fax, please save them carefully for use in the future and for customer support.
You should not format the key diskette if you have a key diskette. This diskette
has been created using special method. When you format or copy it, you canÕt use
it anymore. Please use the key diskette only when you install/remove the authority
for MathMagic. Also, be sure to keep the key diskette safely. You may not install
MathMagic with corrupted key diskette. Contact our support team when you
encounter those situations. You can only repair/exchange it when it was not
corrupted by userÕs intent or by hacking.

1.5 Customer Registration
Please, fill out Customer Registration card or web page and send it to us. When
you are registered, you will be offered various advantages such as product support
and latest product news. Also, You can take benefits from our additional services
such as notification and discount for new products, and invitation to our events. 

You can register via online or fax.

Fax : +82-2-3676-4882 
Web: http://www.mathmagic.com/register / 



This chapter describes how to install MathMagic and how to
authorize your computer to use MathMagic. 
Please read this chapter carefully and follow the descriptions.
And be sure to check this chapter if you want to re-install
MathMagic on other Macintosh.

MathMagic package includes MathMagic XTension, MathMagic
Viewer and MathMagic Fonts.

MathMagic is a Quark XTension for editing equations. MathMagic
Viewer also is a XTension software which only displays and prints
QuarkXPress documents containing equations created using
MathMagic. MathMagic Fonts are TrueType fonts used by
MathMagic or MathMagic Viewer. In case you don’t need to edit
equations, you can just install MathMagic Viewer and MathMagic
Fonts to display and print. For high resolution printing on PostScript
devices including typesetters, you may want to install or download
MathMagic PostScript fonts additionally. PS fonts can also be
installed by MathMagic Installer in Custom Install mode.

Notes
You should not use both MathMagic and MathMagic Viewer
at the same time on the same QuarkXPress folder. You
should install only one of them.

2. Installation
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2.1 Installing MathMagic

To install MathMagic on your Macintosh, please follow this:

1. Download the latest MathMagic Installer or MathMagic Installer CD Image
from MathMagic web site.
When you buy the product, the vendor or InfoLogic should give you the right URL
for downloading.
Or, if you just want to try install a demo version, you can find the latest demo
version from MathMagic download web site at

www.mathmagic.com/download/

2. Decide which computer and which hard disk you want to install.
MathMagic XTension is copy protected. 
It can be installed once on a certain computer on its hard disk. If you installed the
demo version, it runs 15 times from the first installation.(This limitation may vary
without prior notice. Please refer to the Readme file that comes with the installer
for the details).
Once the demo is expired or you want to run the full version, you need to authorize
your copy of MathMagic with a Registration code that was issued by InfoLogic,
Inc.

For the authorization process, please read the following pages.

Notes
If you are using older version of MathMagic prior to 2.1, it may have
a different authorization process than this and you may need to refer
to the old manual that came with your copy of XTension.
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To authorize your hard disk, do this:

1. Launch the installer.
The following splash window appears. 

And then, End user license agreement and ReadMe will also follow.. Please read
carefully these contents before you proceed.

2. Choose the target disk and click Install button. 
You can use ÒEasy InstallÓ in general. But if you need to install any specific items,
you can use ÒCustom InstallÓ mode.. 
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3. Choose a destination QuarkXPress folder if you have more than one copy.
If you have more than one copy of QuarkXPress in your hard disk, the installer you
ask you to choose the right destination to install MathMagic XTension.  

If you choose one or there is only one copy of QuarkXPress application, the
installer will start installation as follows.
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4. Restart your Macintosh after the installation.
After the installation, you will be asked to Restart the computer so that the installed
fonts and other information work fine. 

After Restart, you will see the following window on the desktop, which shows you
what you just installed. The MathMagic XTension will not be in this folder
because it has been installed in the QuarkXPress folder or its XTension folder
properly. Also, please read those installed documents carefully before you use
MathMagic.

5. Launch QuarkXPress. to authorize your copy of MathMagic.
Please find the QuarkXPress application and launch it so that you can activate your
copy of MathMagic. If your computer does not have the authorization already,
MathMagic XTension will alert you to enter the right Serial Number, which is a
registration code. Pleaes note that this is different from your Customer No.
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If you did not receive the correct Serial #, please contact MathMagic Customer
Support Team with your Customer Number right away so that you can get your own
Serial number. 

Email: support@mathmagic.com
Fax: +82-2-3676-4882

Once you receive the serial #, launch QuarkXPress again and enter it.

6. Install MathMagic Demo version if you need to use it right away.
If you do not want to wait until you get the Serial #, you may reinstall MathMagic
Demo version. You can use the demo version without authorization for a limited
period.

7. Use MathMagic XTension now.
Once you successfully installed MathMagic XTension or its
demo version, you can see the following menu or toolbar
botton. 
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2.2 Installing MathMagic Viewer

To install MathMagic Viewer on your hard disk, do this:

1. Download the MathMagic Viewer Installer. Or insert MathMagic CD in your
CD-ROM drive if you have a CD package.

2. Double-click MathMagic Viewer Installer icon.
The MathMagic Viewer splash window appears. 
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3. Click Continue.
Then the main installer window appears. 

4. Click Install to begin installation.
Restart your Macintosh when the installation is completed.
And move the MathMagic Viewer icon into XTension folder of your QuarkXPress
folder.

Notes 
You can use MathMagic Viewer and MathMagic Fonts without any
authorization on any computers including printer service bureau’s Mac.
You can freely download and install MathMagic Viewer when you want
to view or print a document that contains MathMagic equations. But
you are not allowed to bundle any of them to your product or modify
them without any written permission from InfoLogic, Inc.
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2.3 Installing MathMagic Fonts

All necessary MathMagic fonts for equation editing will be installed when you
install MathMagic XTension.
TrueType format fonts will be installed by default.

But in some cases, you may want to install MathMagic fonts additionally.
- when you want to print on a Postscript printer or typesetter, you may want to install
MathMagic PostScript fonts.
- when you want use other optional mathematical fonts that are provided by
IinfoLogic
- when your MathMagic fonts are currupted for some reasons like virus or system
crash.

In this case, you can install MathMagic fonts by using MathMagic Fonts Installer,
which is available separately from MathMagic web site for downloading.
You may also install MathMagic fonts by using any of MathMagic XTension
Installer, MathMagic Demo Installer, or MathMagic Viewer Installer.
You can find more fonts selections in the ÒCustom InstallÓ mode of the installer.

After you install MathMagic fonts again, you may need to restart your computer
before you use MathMagic XTension or MathMagic fonts.



2.4 How to upgrade to the latest version

Once you become a MathMagic user, you will be served with updated versions of
MathMagic continuously either by free update/upgrade or by commercial upgrade.

If you are a registered user of any previous version of MathMagic XTension, you
will be informed via email whenever a newer version is release. The information
will include the details on how to upgrade and the pricing if it is a commercial
upgrade.

The update or upgrade version will also automatically recognize your previous
authorization in the system so that you do not need to reauthorize. But when we
need to improve the authorization process, we may ask you to get the authorization
again with your Customer Number.

1. Free upgrade.
All the minor updates will be offered free of charge. Sometimes major upgrades
might be offered freely to serve our registered customers as much as possible.

2. Commercial upgrade.
When we have a major upgrade version with reasonable amount of improved
features, it might be released as a commercial upgrade.

In general, if you recently purchased a MathMagic package, you will be offered a
free upgrade even though it is commercial. 

MathMagic™16
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B L A N K   P A G E



This chapter describes how to create, edit and adjust equations
as well as printing out. Also you’ll find some examples of how to
create equation.
In later sections, MathMagic menu and its features are
navigated one by one.

3. Using MathMagic
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3.1 Overview

MathMagic XTension handles equations in two ways.

Using Equation Box: Create or edit equation in a similar
way as text box or picture box.

Using Baselined Equation: Based on baseline, equations can be
inserted smoothly into any text just like an anchor box.

When you run QuarkXPress with MathMagic installed, you can see equation
tool icon at the end of tool bar as well as MathMagic menu in Menu bar.
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Equation Tool icon
You can create an equation box and open equation editor window by clicking
Equation Tool icon in the tool bar.

MathMagic menu

About MathMagic... - displays version and credit info.
New Equation - opens MathMagic editor window to create equations at the

cursor position in the text box of the document.
Edit Equation - opens MathMagic editor window to edit selected equation
Convert to Equation - converts selected TeX codes into equation box. See 

3.4 TeX for more details.
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3.2 Create/Edit Equation
Users can create or edit equations in MathMagic Editor window. Symbols in the
Equation window are reorganized to be accessible more easily. MathMagic
Editor offers easy-to-use interface for accurate adjustment of equation
components. 

Creating Equation box
To make an equation box, click Equation Tool icon in Tool Bar and drag 
an area for equations. After the equation box is created, the MathMagic Editor
window appears immediately. Refer to 3.3 Using MathMagic Editor to learn
how to build the equations with MathMagic Editor.

Creating Baselined Equation
Select Create Equation in MathMagic menu or press Command-[ key on
keyboard. Then you will see MathMagic Editor window immediately. Refer to
3.3 Using MathMagic Editor to learn how to write equations with MathMagic
Editor.

Editing Equation
To edit equation in the MathMagic Editor window:

double-click on the equation area or select it and press Command-] key.
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3.3 Using MathMagic Editor

MathMagic Editor is the core part of MathMagic, in which equation is handled.
MathMagic Editor window includes its own menu bar, menu, equation symbol
palette, palette tab, equation symbol popup menu and edit area.

• Palettes
Template - containing various templates of mathematical equations.
Symbol - containing various symbols including operators and greeks.
User - customizable palette for commonly used templates or symbols. Users can 

add frequently used templates and symbols for easy access.
Macro - provides shortcut to commonly used expressions. You can easily

create frequently used equations with macros.

• Edit area
displays equations under work.

• Equation symbol popup menu
Equation symbol menu
pops up when you click an icon 
in Template/Symbol Palettes.

• Menu bar
MathMagic Editor has its 
own menu bar other than the 
menu bar of QuarkXPress.

• Palette tab
allows you to choose template,
symbol, user palette or macro
easily.
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Templates
Templates are a series of collections of mathematical symbols and empty slots
such as     ,     ,     . By simply selecting templates and entering appropriate
characters in each slot, you build equations.

You can create expressions by filling symbols or characters into the space given
by the mathematical symbols. Below is an example of summation template.

Inserting Templates
To insert a template:
1. Open MathMagic Editor and move your cursor to any insertion point.
2. Choose corresponding icon from the Template palette.
3. Select the empty slot and insert characters, symbols or templates. You can also

move the cursor into the slots of other templates by pressing Tab, shift-Tab or 
arrow keys.

Here are all template popup menus and you will learn them one by one.

empty slots

Fences

Fractions

Radicals

Subscripts and Superscripts

Underscript and Overscripts

Summations

Integrals

product and Set - Theory

Alignment

Variables with

primes, ...

Lined box

Framed box

Matrix

Labelled Arrows

Arrows

Bars, Arcs, Braces and Brackets

Space
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Fences

These templates provide you with various ways of
enclosing expressions between matching pair of
symbol, which are called fences or delimiters in
typesetting jargon.

Though you can type (), {} or [ ] on your
keyboard, these canÕt be adjusted along with their
size. The differences between equations created
using fence templates and one using bracket
characters on keyboard are as follows.
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Fractions

This palette provides templates for creating
fraction layouts including diagonal fraction, slash
fraction as well as vertical fraction.

icon and      icon are used for creating full-size
fraction and reduced-size fraction respectively. In
a reduced-size fraction the numerator and
denominator are normally in subscript size and are
placed closer to the fraction bar. You can
customize the spacing for fractions from Define
Spacingcommand in the Format menu. Refer to
page 50 to learn the Define Spacing options.

Radicals

This palette provides templates for creating
radicals and long division layouts. The amount of
space between radicals and their contents can be
controlled using Define Spacingcommand in the
Format menu. You can also align a series of
radicals using Root Alignment command in the
Format menu. This command is activated when a
radical sign has been created. See page 49 to see
more about this command.

Subscripts and Superscripts

This palette provides templates for creating
subscripts and superscripts. Note that these
templates donÕt create slots for  the expression to
which the subscript or superscript is being
attached.
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Underscript and Overscripts

This palette provides templates for creating
subscripts and superscripts. Note that these
templates do create slot to which the subscript or
superscript is being attached.

Summations

You can create various types of sums with these
templates.You can also create repeated sums by
repeated usage of single summation template.
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Integrals

There are thirty integral templates in all, including
single integrals, line integrals, double integrals and
triple integrals, all with various combinations of
integrals.

Products and Set - Theory

These templates are used to create products,
coproducts, and set-theoretic intersections and
unions.
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Bars, Arcs, Braces and Brackets

These templates are used to create expressions
that have bars, arcs, braces or brackets either
under them or over them.

Arrows

These templates are used for creating expressions
that have arrows either under them or over them.

Labelled Arrows

These templates can be used to describe
convergence to a limit or some property of a
function. 
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Matrix

You can build column vectors, determinants,
matrices and other tabular layouts using these
matrix templates. The bottom-end templates
represent variable-size matrice or tables, that bring
up a dialog box for matrix configuration. The
dialog box allows you to specify the number of
rows and columns in your matrix, and how they
are aligned. See below.

Matrix setting dialog also lets you specify lines between rows or columns. You
can just clik the mouse and drag where you want to set lines.

The spacing of entries in a row and the spacing between rows can be controlled
using the Define Spacingcommand on Format menu. 
See page 50 to learn more about the Define Spacingoptions.
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Framed Box

You can frame a box in a few different styles
including fully framed square. 
The thickness of the frame and the gap between
frame and slots can be adjusted in the Define
Spacingdialog.
You can also create an empty frame box by typing
in space characters.

Lined Box

When you need to put a horizontal line, X line,
slash, back slash on a chracter or on a whole box,
you can use these templates
The upper line is for a character and the lower line
is for a box.

Variables with Primes, Hats and Bars

Mathematical variables often have primes, hats,
bars, and dots attached to them. These are known
as diacriticals or accents. These templates will be
attached to the character to the left of the insertion
point. It is possible to attach them several times.
The order in which these templates are applied 
may affect their positioning.

Selecting      icon will remove all the applied
templates from the character.
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Spaces

This palette contains spacing templates that donÕt
have any slots. Each template adds one-point
space, thin space(one sixth of an em), thick space
(one third of an em) and Em space (quad).

Alignment

and      templates are used to align a set of
equations easily. See below to learn what these
templates can do in your expressions.

You can align these two equations by adding Alignment template before each
equality.

- =

+ - = -

x y

x x x y

1

3 5 1

2

3 2 2
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See another example for the latter template.

You can align these two equations by adding      template before each equal sign.

And then, add      template before ÒyÓ of the first equation.

MathMagic automatically determines the necessary spacing value before ÒyÓ.
The last equations clearly look better.

= -

- = + -

y x

y x x x

1

1 3 5

2

2 3 2

= -

- = + -

y x

y x x x

1

1 3 5

2

2 3 2

= -

- = + -

y x

y x x x

1

1 3 5

2

2 3 2

- =

+ - = -

x y

x x x y

1

3 5 1

2

3 2 2
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Symbols
Choosing a symbol icon will insert that symbol into your equations in the
same way that pressing a key will insert a character.

Here are all the symbols that MathMagic supports brief reviews of the each
symbols fallows.

Set Theory

Operator

Extend Operator

Triangle

Arrow

Logical Symbols

Relational Symbols 

Miscellaneous Symbols

Ellipses Symbols

Greek Charactors
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Set Theory

In this palette, there are 20 symbols related to set
theory.

Operator

This palette contains symbols representing
mathematical operators of various types.

Extended Operator

This palette contains additional symbols for
representing mathematical operators of various
types.
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Triangle

This palette provides triangle symbols for
representing normal subgroup relationships.

Arrow

This palette contains icon for 44 arrow symbols.
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Relational Symbols

This palette contains symbols that express various
relationships between two quantities, most of
which involve some notions of equality,
inequality, or equivalence.
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Logical Symbols

This palette provides eight common logical
symbols.

Greek Characters

These two palettes contain icons for the entire
Greek alphabets, both upper-cases and lower-
cases.
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Ellipses Symbols

Normally, an ellipsis is a row of three dots
indicating that items have been left out, usually
because they are obvious from the context. There
are horizontal, vertical and diagonal rows or dots
in this palette.

Miscellaneous Symbols

This palette contains various symbols that are
either somewhat obscure or do not seem to fit in
elsewhere.
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User Palette
Users can store commonly used templates or symbols in the User Palette. Refer

to Chapter 3.6 User Paletteto learn how to use User Palette.

Macro Palette
Users can store frequently used macros in the Macro Palette. Refer to Chapter

3.5 Macro to learn how to use Macro palette.
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Menu

File menu

Open... - opens MathMagic file or TeX file.
Save As - saves the current equation as EPS, PICT or TeX format. When you

choose this menu item, the following
dialog box appears and let you select
a format..

When you choose EPS, equations are
saved as EPS format. EPS files are
used widely in graphic applications
such as Adobe Illustrator“,
Macromedia FreeHand“.
When you select PICT, equations are
saved as PICT format. PICT files can
be read in many other applications
including wordprocessors.
When you select TeX, equations are
saved as TeX document. With this

option you can use MathMagic equations in various external TeX editors. For
more information about TeX documents, refer to Chapter3.4 TeX.

Save In Document- saves the contents of the current equatin windows into the
QuarkXPress document.
Close - saves the current equation into the QuarkXPress document and closes
MathMagic Editor window.
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Edit menu

Undo / Redo - undo or redo the previous action
Cut - copies selection to clipboard and
removes it from the editor window.
Copy - copies selection to clipboard.
Paste- inserts equations or texts from
clipboard to cursor position.
Clear - removes selection without copying on
the clipboard.
Select All - selects all contents in the
MathMagic Editor window.

Add Macro - adds selection to Macro Palette as a macro. You can add a macro 
by choosing this command from Edit menu or by pressing Command-M.

User Items Hotkey- See page 65
Macro Items Hotkey - See page 62

Template follows - when you press command-T, MathMagic waits for the next
key to insert a template that is assigned to that shortcut key.
Symbol follows- when you press command-K, MathMagic waits for the next
key to insert a symbol that is assigned to that shortcut key.
For the details on the shortcut keys, refer to Appendix C. 

Notes
MathMagic has its own keyboard shortcuts by default. Refer to
Appendix C for details about MathMagic keyboard shortcuts.
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View menu

You can change the viewing scale from this menu by choosing values among
100%, 200% and 400%.

The view size in MathMagic Editor window somewhat differs from the actual
size of your QuarkXPress documents. 

You use Refreshcommand to redisplay the equation in the current window at
the current scale. This is useful for cleaning up the display. 

And you use Show Controlscommand to turn on and off the display of certain
special symbols in the equations. These symbols include various types of spaces.

Show control on Show control off



Font menu

The selected fonts are only applied to texts in the MathMagic Editor window.
The font doesnÕt apply to equation templates or symbols.

Style menu

Math - changes selection to MathMagic deault style.

Function - changes selection to function style.
MathMagic basically recognizes 
the following as functions.
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sin cos tan sec csc cosec cot

arcsin arccos arctan

sinh cosh tanh coth

exp ln log

min max inf sup glb lub

lim hom ker dim

arg deg det mod gcd int

Im Re Pr var cov

These functions are automatically changed to function styles. Functions other
than the aboves can be manually set to function style from this menu.

Variable - changes selection to Variable style.
Plain - changes selection to Plain style.
Bold - changes selection to Bold style.
Italic - changes selection to Italic style.
Define StyleÉ - This command allow you to change the assignment of font and 

character style. Choosing this command brings up the following dialog box.

Each row in the table gives the current definition of one of the styles. In a given
row, there are entries showing the font and character style currently assigned to
the style. Pressing on the font name activates a pop-up menu from which you
can choose a different font.



Size menu

Full - changes the font size of functions, variables,
numbers and texts to 12pt or 
defined size.
Subscript - changes the font size of
super/subscripts to defined size.
Sub-Subscript - changes the font size of sub-
super/subscripts to defined size.
Symbol - changes the font size of mathematical
symbols to defined size.
Sub-symbol- changes the font size of sub
mathematical symbols to defined 
size.

Define Size- You can change the definition of any
type size using the Define Sizecommand.
Choosing this command brings up the following
dialog box.

The pictures in the dialog box show the meanings and uses of each of the type
sizes.
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The default unit of measurement for type sizes is points. If you simply type a
number, MathMagic will assume that you want to use points unit. You can
specify a type size as a percentage of your Full typesize, because then you wonÕt
need to change it in the event that you change your Full typesize. You can do
this simply by typing a number followed by a % sign.
For example, suppose your Full typesize is defined as 12pt. If you set your
Subscript typesize to 75%, then your subscripts will be in 9pt size, but if you
later change your Full type size to 10 points, your subscripts will automatically
change to 7.5pt. Note that the Full typesize canÕt be followed by % sign.

Format menu

The format menu is used to control the positioning of portions of equations. The
first three commands control horizontal alignment, and the next three control
vertical alignment. The horizontal alignment commands are applied to ÒpilesÓ of
equations.
Nudgemeans point by point movement for an accurate adjustment for a
selection.



Align Left - moves lines horizontally so that their left-hand ends are aligned.
Align Center - moves lines horizontally so that their centers are aligned.
Align Right - moves lines horizontally so that their right-hand ends are aligned.
Align Top - moves lines or matrix containing the insertion point so that its top 

line aligns with the line containing it.
Align Base- moves lines or matrix containing the insertion point so that its 

baseline aligns with the line containing it.
Align Bottom - moves lines or matrix containing the insertion point so that its 

bottom line aligns with the line containing it.
Nudge Left / Right / Up / Down- moves the selection to the specified direction
with 2304 (32 * 72) dpi accuracy, which means you can move a selection by
1/2304 inch. 
Set Nudge Position- selecting this menu item or pressing command-5, will
show up a dialog as well as let you set the Nudge value accurately. 

Fence AlignmentÉ - This feature allows you to easily adjust the alignment of
items within fences (brackets, parentheses, braces, etc.). Fences are normally
centered with respect to the height where the horizontal strokes of minus signs
and addition signs are located. This doesnÕt always look exactly the way you
want it. For example, see below.

The numerator in the above expression is much taller than the denominator,
resulting in a large white gap at the bottom of the expression. Choosing this
command brings up the following dialog box. (Place your cursor next to the
bracket or select the entire template to activate this command.)
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Simply select the preferred option from the three choices, and click OK. The
results are as follows.

Each choice has its own advantages, and the correct selection will depend on the
expression itself case by case.

Root Alignment - brings up a dialog box that let you choose one of the two 
alignment for equations in which a series of radicals are used.

The first option represents
alignment with respect to the
character baseline.
In the second option, the
radical signs are extended
vertically for alignment.
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Define Spacing- You can adjust the values of subscript depth, numerator height
in fractions, fraction bar overhang, line thickness, and so forth by using this
command. 
When you choose this command, the following dialog box appears.

As you can see, you can swtich to each tab to set its dependant values.
The illustration on the right side shows you the meaning of each item that affects
to the result visually. The blue arrow normally tells the gap or thickness that is
affected by the value of the current selected value box. The green line shows you
the base line or base point.
The default unit of measurement for typesizes is points. If you simply type a
number, MathMagic will assume that you want to use points unit. You can
specify a typesize as a percentage of your Full typesize,because then you won Õt
need to change it in the event that you change your Full typesize.You can do
this simply by typing a number followed by a %sign.
You can save your settings as a default value set for future use in the document
by clicking ÒMake DefaultÓ. The value set can be refilled by ÒUse DefaultÓ
button next time. 
ÒFactory SettingsÓ button will reset all the current values to the MathMagic
recommended ones. ÒApplyÓ will show you the applied result in the document
without leaving this dialog.
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Locating Insertion Point
When you edit or create equations in MathMagic Editor, it is important to check
where the cursor is. Blinking cursor indicates current insertion point. And you
should move the cursor to correct insertion point. Below is an example showing
the current cursor location in MathMagic Editor.

You can move the insertion point using mouse or keyboard arrows.
Also, you can move your cursor into the next slot of a template pressing Tab or
shift-Tab key. Now, letÕs create a simple equation to see how to insert templates
and symbols as well as how to move the cursor.



1. Open MathMagic Editor window by selecting New Equation from MathMagic 
menu in the menu bar or by clicking equation tool icon in the tool bar and
draw an equation box.

2. Type Òx=Ó on your keyboard.

3. Click the fraction icon      in Template Palette and select icon. The cursor is 
automatically located at the denominator by default.
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4. Type Ò2Ó and ÒaÓ on your keyboard and press Tab key to move the cursor into 
the numerator slot.

5. Type Ò-Ó and ÒbÓ on your keyboard.

6. Switch to Symbol Palette and click the operator icon and select icon     .

7. Click the radical icon in the Tempalete Palette and select icon     .



8. Type ÒbÓ on your keyboard.

9. Click subscripts icon in the Template Palette and select icon     .

10. Type Ò2Ó on your keyboard.
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11. Press Tab key or the right arrow key to move the insertion point into 
next slot.

12. Type Ò-Ó, Ò4Ó, ÒaÓ and ÒcÓ on your keyboard.

The result should be shown as below in the final printout.

=
- -

x
a

b b ac

2

42!



3.4 TeX
There is another way to write mathematical equations. TeX - the professional
mathematics markup language - is widely used in fields such as science and advanced
mathematics, and is used to write technical papers especially in science or engineering
colleges and research institutes.

MathMagic provides capability of converting TeX-to-equation and equation-to-TeX.
The following is an equation and its TeX strings.

$$\int_{3}^{1}{(x\nolimits^{2}-4x+3)\ dx}$$

In case you need to use TeX-based equations or to convert MathMagic equations into
TeX, read this chapter carefully.

Notes
MathMagic does not support full features of TeX. MathMagic can read
equations from TeX codes, and does not support the TeX-based
typography or page attributes. For more info about features of TeX
codes supported by MathMagic, refer to the Appendix B. TeX codes
supported by MathMagic.
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Converting TeX into Equations

To convert TeX codes into equation forms, do this:
¥ Importing TeX document to MathMagic
1. Open MathMagic Editor window.
2. Choose Open... item in the File menu.

3. Locate your TeX document in the standard Open dialog box.

Converted equations appear in the MathMagic Editor window.

¥ Converting TeX sentences into equations

1. Type TeX code in Text box of QuarkXPress or choose Get Text command
in File menu to open a TeX document.



2. Select TeX sentences to convert, and then choose Convert to Equation in
MathMagic menu.

The selected TeX codes are converted into an equation form.

Notes
When you try to convert TeX codes that MathMagic doesn’t
support, a warning message is displayed. In this case, the TeX 
document won’t be converted completely.
In this case, we recommand you to remove those unsupported
TeX codes and then try again.
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Converting Equations into TeX

In order to convert equation forms into TeX codes, do this:

1. Choose Save in File menu of MathMagic Editor.
You can see a standard save dialog box.

2. Select TeX from Format popup menu.
3. Type appropriate file name and click Save. 

The saved file is plain text format containing TeX codes.



3.5 Macro Palette
To add new macro in Macro Palette, do this:

1. Type equations or strings for a new macro.

2. Select them and choose Add Macro in Edit menu. Then you can see newly 
generated macro button. 

MathMagic™60



61

The macro button contains thumbnail snapshot based on its contents. You can
also add macro by pressing keyboard shortcut (Command-M).

To remove a macro in Macro Palette, do this:

1. Switch to the Macro Palette.
2. Command-click the macro button to remove. By doing this, the macro button 

is removed immediately.



Define hotkeys for macros
When you have created some macros in the Macro Palette, you can define a
keyboard shortcut for each macro button.

To define a shortcut for a macro, do this:

1. Choose Macro Items Hotkey... in the Edit menu.

Then you should see a list window.
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2. Select an item from the list and define a shortcut by pressing a character with 
Shift, Control, Option or Command key combination. Shift, Control, Option
or Command key whould be included in the shortcut.

3. Click OK to apply the changes.



3.6 User Palette
To add new user items in User Palette, do this:
1. Switch to Template Palette or Symbol Palette.
2. Command-click your preferred templates as many as you wish. If you want to

check the generated user items, switch to User Palette.

To remove user items in User Palette, do this:
1. Switch to the User Palette.
2. Command-click the user items to remove. By doing this, the user items are

removed immediately.
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When you have created some user items in the User Palette, you  can define a
keyboard shortcut for each user item.

To define a shortcut for an item, do this:

1. Choose User Items HotkeyÉ in the Edit menu. Then you should see a list 
window.

2. Select an item from the list and define a shortcut by pressing a character with 
Shift, Control, Option and/or Command key combination. Shift, Control,
Option or Command key will be included in the shortcut.

3. Click OK to apply the changes.
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3.7 Printing
When you contact your printing service bureau to print your documents created
with MathMagic XTension, you need to bring MathMagic Viewer and
MathMagic Fonts. Anyone can use MathMagic Viewer and MathMagic Fonts
without authorization, and those can be freely distributed as freeware. 
But you should keep in mind that you are not allowed to modify them without
prior notification to InfoLogic, Inc. 
Printing service bureau can offer better quality printouts with MathMgic
PostScript fonts installed. MathMagic Postscript fonts can also be installed in
your Fonts folder in the System folder together with TrueType fonts. In this case,
the Postscript printer driver will use PS fonts prior to TT fonts after it
determines if PS fonts are available.

Notes
Do not install both MathMagic XTension and MathMagic Viewer in
the same QuarkXPress folder. Only one of the two XTensions
should be installed.

Color Trapping Support
MathMagic supports color trapping for professional desktop publishing.
But, please note that only the default trap values of each color can be applied.
You canÕt use customized values in the Trap Information palette. If you do need
to apply other color trapping value, create a separate color, and then edit the trap
value.



Appendix A. Support

About Customer Support
If you would like to take full advantage of our Customer Services, please send us
the Customer Registration Card via email or fax. You can also register on our
website at http://www.mathmagic.com/register/ 

If you encounter any problems in using MathMagic, please contact us at the
following address.

MathMagic Customer Support Team

Email: support@mathmagic.com
TEL: +82-2-3676-4883
FAX: +82-2-3676-4882
http://www.mathmagic.com/support/ 

Trouble shooting and FAQ
You can get the latest infomation for trouble shooting and FAQ of MathMagic at
our homepage, http://www.mathmagic.com/support/.



Appendix B. TeX Codes supported by MathMagic

\above \abovewithdelims

\acute \acute

\aleph \Alpha

\alpha \amalg

\And \angle

\approx \approxeq

\arrowhorizex \arrowvertex

\ast \asymp

\atop \atopwithdelims

\backepsilon \backsim

\backsimeq \backslash

\backtriangle \bar

\bar \barwedge

\Bbbk \because

\Beta \beta

\beth \between

\bf \big

\bigcap \bigcap

\bigcirc \bigcup

\bigcup \Bigg

\bigg \Biggl

\biggl \Biggm

\biggm \Biggr

\biggr \Bigl

\bigl \Bigm



\bigm \bigodot
\bigodot \bigoplus
\bigoplus \bigotimes
\bigotimes \Bigr
\bigr \bigsqcup
\bigsqcup \bigstar
\bigtriangledown \bigtriangleup
\biguplus \biguplus
\bigvee \bigvee
\bigwedge \bigwedge
\binom \blacklozenge
\blacksquare \blacktriangle
\blacktriangledown \blacktriangleleft
\blacktriangleright \bordermatrix
\bot \bowtie
\Box \boxdot
\boxminus \boxplus
\boxtimes \bprime
\bprime \brace
\braceleftbt \braceleftex
\braceleftmid \bracelefttp
\bracerightbt \bracerightex
\bracerightmid \bracerighttp
\brack \bracketleftbt
\bracketleftex \bracketlefttp
\bracketrightbt \bracketrightex
\bracketrighttp \breve
\breve \buildrel
\bullet \Bumpeq
\bumpeq \Cap
\cap \cases
\cdot \centerdot

\check \check

\Chi \chi

\choose \circ
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\circeq \circlearrowleft

\circlearrowright \circledast

\circledcirc \circleddash

\circledS \clubsuit

\complement \cong

\coprod \coprod

\cr \Cup

\cup \curlyeqprec

\curlyeqsucc \curlyvee

\curlywedge \curvearrowleft

\curvearrowright \dag

\dagger \daleth

\dashv \dbinom

\ddag \ddagger

\dddot \dddot

\ddot \ddot

\def \Delta

\delta \dfrac

\diag \diagdown

\diagup \Diamond

\diamond \diamondsuit

\digamma \displaylines

\displaystyle \div

\divideontimes \dot

\dot \doteq

\doteqdot \dotplus

\doublebarwedge \doubleprime

\dover \Downarrow

\downarrow \downarrowhead
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\downdownarrows \downharpoonleft

\downharpoonright \dvert

\ell \emptyset

\Epsilon \epsilon

\eqalign \eqalignno

\eqbase \eqbottom

\eqcenter \eqcirc

\eqleft \eqright

\eqslantgtr \eqslantless

\eqtop \equiv

\Eta \eta

\eth \exists

\fallingdotseq \Finv

\flat \font

\forall \frac

\from \frown

\fullstyle \Game

\Gamma \gamma

\gather \gdef

\geq \geqq

\geqslant \gg

\ggg \gimel

\gnapprox \gneq

\gneqq \gnsim

\grave \grave

\gtrapprox \gtrdot

\gtreqless \gtreqqless

\gtrless \gtrsim

\gvertneqq \halign
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\hat \hat

\hbar \heartsuit

\hfill \hookleftarrow

\hookrightarrow \hslash

\iiint \iiint

\iint \iint

\Im \imath

\in \infty

\int \int

\integralbt \integralex

\integraltp \intercal

\Iota \iota

\it \jmath

\Join \Kappa

\kappa \Lambda

\lamda \langle

\langle \lbrace

\lbrace \lbracket

\lbracket \lceil

\lceil \leadsto

\left \Leftarrow

\leftarrow \leftarrowhead

\leftarrowtail \leftharpoondown

\leftharpoonup \leftleftarrows

\Leftrightarrow \leftrightarrow

\leftrightarrows \leftrightharpoons

\leftrightsquigarrow \leftthreetimes

\leq \leqalignno

\leqq \leqslant
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\lessapprox \lessdot

\lesseqgtr \lesseqqgtr

\lessgtr \lesssim

\lfloor \lfloor

\lhd \limits

\ll \Lleftarrow

\lll \lnapprox

\lneq \lneqq

\lnsim \longleftarrow

\longleftrightarrow \longrightarrow

\looparrowleft \looparrowright

\lozenge \lparen

\lparen \Lsh

\ltimes \lvertneqq

\mapsto \mathbin

\mathclose \mathop

\mathopen \mathord

\mathpunct \mathrel

\matrix \measuredangle

\medspace \mho

\mid \mid

\midbar \models

\mp \Mu

\mu \multimap

\natural \ncong

\nearrow \neg

\neq \nexists

\ngeq \ngeqq

\ngeqslant \ngtr
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\ni \nLeftarrow

\nLeftrightarrow \nleftrightarrow

\nleq \nleqq

\nleqslant \nless

\nmid \noalign

\nolimits \not

\notin \nparallel

\nprec \npreceq

\nRightarrow \nrightarrow

\nshortmid \nshortparallel

\nsim \nsubseteq

\nsubseteqq \nsucc

\nsucceq \nsupseteq

\nsupseteqq \ntriangleleft

\ntrianglelefteq \ntriangleright

\ntrianglerighteq \Nu

\nu \nVDash

\nVdash \nvDash

\nvdash \nwarrow

\odot \of

\oiiint \oiiint

\oiint \oiint

\oint \oint

\Omega \omega

\Omicron \omicron

\ominus \operatorname

\operatornamewithlimits \oplus

\oslash \otimes

\over \overbrace
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\overbrace \overbracebt

\overbraceex \overbracemid

\overbracetp \overbracket

\overbracket \overbracketbt

\overbracketex \overbrackettp

\overeq \overleftarrow

\overleftrightarrow \overline

\overparen \overparen

\overparenbt \overparenex

\overparentp \overrightarrow

\oversetbrace \overwithdelims

\P \parallel

\parallel \parenleftbt

\parenleftex \parenlefttp

\parenrightbt \parenrightex

\parenrighttp \partial

\perp \Phi

\phi \Pi

\pi \pitchfork

\pm \pmatrix

\prec \precapprox

\preccurlyeq \preceq

\precnapprox \precneqq

\precnsim \precsim

\prime \prime

\prod \prod

\propto \Psi

\psi \qquad

\quad \rangle

Appendix B. TeX Codes supported by MathMagic



\rangle \rbrace

\rbrace \rbracket

\rbracket \rceil

\rceil \Re

\rfloor \rfloor

\rhd \Rho

\rho \right

\Rightarrow \rightarrow

\rightarrowhead \rightarrowtail

\rightharpoondown \rightharpoonup

\rightleftarrows \rightleftharpoons

\rightrightarrows \rightsquigarrow

\rightthreetimes \risingdotseq

\rm \root

\rparen \rparen

\Rrightarrow \Rsh

\rtimes \S

\sb \scriptarrowhorizex

\scriptarrowvertex \scriptdownarrowhead

\scriptleftarrowhead \scriptrightarrowhead

\scriptscriptstyle \scriptstyle

\scriptsymbolstyle \scriptuparrowhead

\shortparallel \Sigma

\sigma \sim

\simeq \size

\skew \slash

\smallfrown \smallint

\smallsetminus \smallsmile

\smile \sp
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\space \spadesuit

\sphericalangle \sqcap

\sqcup \sqrt

\sqsubset \sqsubseteq

\sqsupset \sqsupseteq

\square \star

\struct \Subset

\subset \subseteq

\subseteqq \subsetneq

\subsetneqq \succ

\succapprox \succcurlyeq

\succeq \succnapprox

\succneqq \succnsim

\succsim \sum

\sum \Supset

\supset \supseteq

\supseteqq \supsetneq

\supsetneqq \surd

\swarrow \symbolstyle

\Tau \tau

\tbinom \tdiag

\text \textstyle

\tfrac \therefore

\Theta \theta

\thickapprox \thickfrac

\thicksim \thickspace

\thinspace \tilde

\tilde \times

\to \top
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\tover \triangle

\triangledown \triangleleft

\trianglelefteq \triangleq

\triangleright \trianglerighteq

\triangleup \tripleprime

\twoheadleftarrow \twoheadrightarrow

\underbrace \underbrace

\underbracebt \underbraceex

\underbracemid \underbracetp

\underbracket \underbracket

\underbracketbt \underbracketex

\underbrackettp \undereq

\underleftarrow \underleftrightarrow

\underline \underparen

\underparen \underparenbt

\underparenex \underparentp

\underrightarrow \undersetbrace

\unlhd \unrhd

\Uparrow \uparrow

\uparrowhead \Updownarrow

\updownarrow \upharpoonleft

\upharpoonright \uplus

\Upsilon \upsilon

\upuparrows \varepsilon

\varkappa \varnothing

\varphi \varpi

\varpropto \varrho

\varsigma \varsubsetneq

\varsubsetneqq \varsupsetneq
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\varsupsetneqq \vartheta

\vartriangle \vartriangleleft

\vartriangleright \Vdash

\vDash \vdash

\vec \vec

\vee \veebar

\Vert \vert

\Vvdash \wedge

\xint \xoiiint

\xoiint \xoint

\Zeta \zeta
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Appendix C. Keyboard Shortcuts

Many templates and symbols are assigned default keyboard shortcuts. These include

templates for parentheses, brackets, fraction, etc. 

See below table for the list of default shortcuts. 

User also can define a set of shortcut keys for User items and Macros.

Symbol Shortcuts

command-K, I

command-K, C

command-K, shift-C

command-K, E

command-K, shift-E

command-K, U

command-K, shift-U

command-K, <

command-K, >

command-K, shift-<

command-K, shift->

command-K, =

command-K, shift-=

command-K, -

command-K, shift- -

command-K, T

command-K, shift-T

command-K, S

command-K, shift-S

command-K, A

command-K, shift-A

command-K, D



command-shift-9  or  cmd-shift-0
command-T, 9 or 0
command-[  or  command-]
command-T, [ or ]
command-shift-{  or  cmd-shift-}
command-T, shift-{ or shift-}
command-T, \

command-T, shift-|

command-T, shift-[  or  shift-]

command-F
command-T, F

command-T, shift-F

command-/
command-T, /

command-T, shift-/

command-T, D

command-T, shift-D

command-R
command-T, R

command-T, shift-R
command-H
command-T, H
command-L
command-T, L

command-T, J

command-T, S

command-T, shift-S

command-T, control-S

Template Shortcuts

command-I
command-T, I

command-T, shift-I

command-T, control-I

command-T, P

command-T, shift-P

command-T, control-P

command-T, N

command-T, shift-N

command-T, control-N

command-T, M

command-T, shift-M

command-T, B

command-shift-HYPHEN

command-option-HYPHEN

command-shift-~

command-option- '

command-shift- "

command-control- "

command-option-PERIOD(.)

command-shift-PERIOD(.)

command-control-PERIOD(.)



MathMagic supports  commonly used editing keys in the equation editor
window. Some keys are as followings.

Editing Keys

KKeeyybbooaarrdd BBeehhaavv ii oo rr

right arrow Move  cursor to the right
At the end of a template box, move to the beginning of the next
box

left arrow Move cursor to the left
At the beginning of a box, move to the end of previous box

down arrow Move to the same point of the next line
up arrow Move to the same point of the previous line

cmd-right arrow Move to the end fo the line
cmd-left arrow Move to the beginning of the line
cmd-down arrow Move to the end of the document
cmd-up arrow Move to the beginning of the document

shift-right arrow Move  cursor to the right, and select in-between contents
shift-left arrow Move cursor to the left, and select in-between contents
shift-down arrow Move to the same point of the next line, and select in-between

contents
shift-up arrow Move to the same point of the previous line, and select in-

between contents

shift-cmd-right arrow Move to the end fo the line, and select in-between contents
shift-cmd-left arrow Move to the beginning of the line, and select in-between contents
shift-cmd-down arrow Move to the end of the document, and select in-between contents
shift-cmd-up arrow Move to the beginning of the document, and select in-between

contents

tab Move cursor to the end of current box
At the end of a box, move to the beginning of the next box

shift-tab Move cursor to the beginning of current box
At the beginning of a box, move to the end of the previous box

return, enter Add a new line as a same level of current line
In the middle of a box, breaks the line and move the right part to
the next line

delete (backward) Delete the left character of the cursor
If it is a template, select the box first and then delete it by
another delete key

del  (forward delete) Delete the right-side character of the cursor
If it is a template box, just select the box



Menu Shortcuts

File
Open... cmd-O
Save in Document cmd-S
Close cmd-W

Edit
Undo / Redo cmd-Z
Cut cmd-X
Copy cmd-C
Paste cmd-V
Select All cmd-A
Add Macro cmd-M
Template follows cmd-T
Symbol follows cmd-K
Set Environment cmd-E

View
100 % cmd-1
200 % cmd-2
400 % cmd-4
Refresh cmd-D
Show Controls cmd-Y

Style
Plain cmd-shift-T
Bold cmd-shift-B
Italic cmd-shift-I
Define Style... cmd-=

Size
Other... cmd-shift-O
Define Size... cmd- -

Format
Nudge option- arrow keys
Set Nudge Position cmd-5
Fense Alignment cmd-6
Root Alignment cmd-7
Define Spacing... cmd-8



Appendix D. MathMagic Fonts list

MMArrow
!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRS

TUVWXYZ[\]^_`ab

MMBinary
!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRSTUVWXYZ[

MMCenturyOld, MMCenturyOldE
MMCenturyOldK, MMCenturyOldO, MMCenturyOldS 

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRS`abcdefghijklmnox

MMCenturyOldGreek
ABCDEFGHIJKLMNOPQRSTUVWXabcdefghijklmnopqrstuvwxyz{|}~�

MMEtc
!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]

^_`abcdefghijklmnopqrstuvwxyz{|}

MMExtra 
MMGreek

ABCDEFGHIJKLMNOPQRSTUVWXabcdefghijklmnopqrstuvwxyz{~

MMNegate
!"#$%&'()*+,/0123456789:;<=>?@ABCDEFGHIJKLMNOPQTUXYZ[\

MMRelation
!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRSTUV
WXYZ[\]^_`abcdefghijklmnopqrstuvwxyz{|}~�ÄÅÇÉÑÖÜá

MMTextbook
!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_`a
bcdefghijklmnopqrstuvwxyz{|}~

MMTimes
!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_`abcde

fghijklmnopqrstuvwxyz{|}~

MMVariable, 
MMVariableA, MMVariableB, MMVariableC, MMVariableD



Index

A

Add Macro 42, 60

Align Base 48

Align Bottom 48

Align Center 48

Align Left 48

Align Right 48

Align Top 48

Alignment 31, 47, 50

Arc 29

Arrow 29, 36

Authorization 8, 9, 15, 16, 17

B

Bar 29, 33

Baselined Equation 20

Brace 29

Bracket 29

C

Color Trapping 3

Column 30

Convert to Equation 58

Creating Equation 22

Customer Registration 6

Customer Support 67

D

Define Size 46

Define Spacing 26, 30, 48

Define Style 45

E

Edit menu 42, 62

Editing Equation 22

Ellipses Symbol 39

Em space 33

EPS 3, 41

Equation Box 20

Equation Tool 21

Export 41

Extended Operator 35

F

FAQ 67

Features 2

Fence 25

Fence Alignment 49

File menu 41, 57

Font menu 44

Format menu 47

Fraction 26

Full 46

Function 44, 45, 46



G

Greek alphabet 38

Greek Character 38

H

Hat 33

I

Import TeX 41, 57

Infinite 39

Installation 7

Integral 28

Italic 45

K

Key Diskette 5, 6, 9, 15

Keyboard shortcuts 42, 81

L

Labelled Arrow 29

Licence Agreement 4

Locating Insertion Point 51

Logical Symbol 38

Lower-case 38

M

Macro 4, 23, 40, 42

Macro Items Hotkey 42, 62

Macro Palette 40, 60, 61

Math 44

MathMagic 19

MathMagic Editor 23, 51, 57

MathMagic Font 2, 7, 14, 66

MathMagic menu 21

MathMagic Viewer 4, 7, 13, 14, 66

Matrix 30, 48

Menu 41

Miscellaneous Symbol 39

N

Number 46

O

Operator 35

Overscript 27

P

PICT 3, 41

Plain 45

PostScript 2, 66

Primes 33

Printing 66

Product 28

R

Radical 26

Refresh 43

Relational Symbol 37

Root 26

Root Alignment 26, 50



Row 30

S

Set 28, 35

Show Controls 43

Sigma 27

Size menu 46

Space 33

Style 45

Style menu 44

Sub-Subscript 46

Sub-symbol 46

Subscript 26, 46

Summation 27

Superscript 26

Support 67

Symbol 34, 46

System Requirements 5

T

Template 24

TeX 3, 41, 56, 69

Triangle 36

Troubleshooting 67

U

Underscript 27

Upper-case 38

User Items Hotkey 42, 65

User Palette 3, 4, 40, 42, 64

V

Variable 33, 45, 46

View menu 43

www.mathmagic.com


